HOW DO I BEGIN?

I strive for two things in design: simplicity and clarity.
—Lindon Leader

Don’t do what I did! When I was a new instructional designer, I had the opportunity to collaborate with our academic administrative team to develop faculty workshops for teaching online. Initially those workshops were offered face-to-face, and we covered major topics like community building, course design, teaching techniques, and assessment. As our faculty grew and adjunct instructors were located farther away from our main campus, the academic administrative team began to consider blended and fully online workshop options. When I began to redesign the face-to-face course for fully online delivery, I wanted to make sure that faculty taking the workshops online, received the same benefit of our team’s experiences as if we were all training together in a classroom. So I included in the redesign everything (and I do mean everything) we had shared in the face-to-face training. As a result, the first version of the online course looked like Figure 1.1. Folders contained folders that contained several content items and additional folders. Faculty practically needed to memorize the organizational scheme to find any one content item of interest. As the course developer, even I could not recall the organizational scheme I had created when I needed to direct faculty to a specific content item. Simplicity and clarity are important aims for designers in any field—and Figure 1.1 falls short of both aims.

To use a colloquial expression common among United States southerners, the course excerpt in Figure 1.1 is a “hot mess”! A hot mess describes anything in a state of extreme disorder or disarray. I don’t mind poking fun at my earlier course design attempts. We all start somewhere,
and I was very proud of that hot mess after I built it. At that time, I was simultaneously learning the features of Blackboard, my institution’s learning management system, and providing support to faculty as they taught and built courses online. So why would I say the example in Figure 1.1 is a hot M.E.S.S.? Four reasons:
• Many new technologies were rapidly thrust upon faculty in a short time span. This inadvertently drew the focus away from the learning objectives. Frustration set in as faculty attempted to use the technologies for the first time, navigate many content folders to locate needed resources, and apply the content.

• Excessive amounts of nice-to-know content flooded the course. Nice-to-know content is content that is not directly related to learning objectives. There is a vast amount of information available on any given topic. As course designers and developers, it’s our responsibility to vet the information and use our professional judgment to select the one, two, or three resources that will best help a learner attain the desired outcomes of the course.

• Several related content items were created as individual resources. Creating individual content items for related resources can overwhelm learners with volumes of content and waste valuable study time with unnecessary clicks and page loading time.

• Supplemental resources mixed with required resources makes it difficult to differentiate important content from optional content. Label supplemental resources as optional so that learners can prioritize the resources needed to attain learning outcomes.

When all four of these issues are present in a content folder, learning module, or course, we take the focus away from course learning outcomes. Combined, these issues thwart development of any sense of learner self-efficacy by raising anxiety that hinders meaning making and creating clutter that steals time away from the learning task. This threaten retention and course completion by overwhelming students, particularly those who may be adjusting to learning online.

While I achieved my goal of packing into the course everything I thought we shared in the face-to-face training, I also guaranteed that faculty wouldn’t be able to find any one thing for which they might be looking. Faculty trying to find a piece of content probably got the same knot in their stomach that I get when I’m looking for a specific item in the garage that has been packed away for a couple of years. Although the boxes in the garage are clearly labeled, I can never remember where one
specific item is located. That is exactly what happened in the first few online workshops I designed for faculty. When faculty asked which folder a specific item was in, sometimes I couldn’t remember. This can happen when there is a high “folder depth ratio.” A high folder depth ratio occurs when content folders are nested in several layers of additional content folders. So the first thing I learned about course design was to keep the design light. To do this, I had to accept that online teaching is different from teaching face-to-face in a classroom—not better or worse, just different. While both delivery formats can offer high-quality content, interactions, and collaboration, they differ in how it’s done. Both delivery formats can be rigorous and challenging but differ in the techniques and tools used to achieve the same end. Therefore, there is no need to fill the online space with an abundance of content and information. Instead, the goal is to design the online climate so that the opportunity for quality instruction, peer interactions and collaboration, rigor, and challenge is the same as in face-to-face classroom instruction.

So the question now becomes, how do you design an online environment where there are opportunities for quality instruction, peer interactions, collaboration, rigor, and challenge without opening the floodgates of massive amounts of content nested three and four folders deep? My suggestion: keep the course design light. Imagine the feeling you have when a burden has been lifted, a challenge has been surmounted, or a conflict is resolved—that light feeling you get when tension has been released through exercise, prayer, a massage, or a relaxing evening doing what you love to do. Learning something new or pursuing a goal come with tensions as you wrestle with new concepts. However, tensions shouldn’t come from an abundance of material that hasn’t been vetted properly. Tensions shouldn’t come from not being able to find the resources you need to achieve what is expected. Tensions shouldn’t come from the technology itself.

Keeping the course design light will help avoid the hot mess in Figure 1.1. What does it mean to keep a course light? First, the content presented is focused on specific objectives based on what you want the learner to do or consider at the conclusion of the course. The course navigation keeps the learner within a few clicks of any resource needed. Second, the learning
technologies used are explained, supported, and kept to a minimum. The more technologies students are expected to use, the more content is required to explain and support the technologies used. Keeping the course design light facilitates a focus on learning outcomes, as follows:

1. Reducing the number of new technologies integrated into the course increases familiarity with required technologies, leaving students more mental energy for synthesizing course content.
2. Purging excessive amounts of content, whether assignments or resources, helps students manage their time on task.
3. Merging related content items contributes to a lower folder depth ratio, so students can more easily find what they need when they need it.
4. Separating required resources from optional resources focuses the learners’ attention on the resources directly related to attaining learning objectives.

With that in mind, I’d like to highlight four basic technology skills that will facilitate a light course design. Using the acronym L.I.T.E. will help us to remember them. These foundational skills will be developed in the remaining chapters:

• Links—Create clickable links to external content.
• Integrate multimedia—Merge similar or related text, video, audio, still images, graphics, animation, hypermedia, simulations, and other types of interactive objects.
• Typography—Enhance readability and legibility by using fonts, font size, bullets, numbering, and line spacing to create white space.
• Embed—Display content at the point of need.

Keeping the design L.I.T.E. prevents a M.E.S.S. and also complements the Universal Design for Learning (UDL) framework, when applied to courses designed in a learning management system or website. The UDL framework advocates making content accessible to all learners, with and without disabilities (Center for Applied Special Technology, 2011). As disabilities can
be both seen and unseen, the L.I.T.E. skills and the UDL framework provide a foundation from which to provide visual support to all learners as they access instructional materials online. Who do we mean by “all learners”? The UDL framework considers the needs of novices entering a new field of study; experienced practitioners formalizing their education; second-language learners acquiring the academic language of their discipline; young adults through mature seniors on the continuum of social, cultural, linguistic, and economic diversity; as well as students with varied learning styles. Because learners using various devices can customize online content, UDL encourages the representation of content in multiple formats that include auditory, visual, and text materials.

“Content is king!” You’ve probably heard this expression. Knowing what you want learners to be able to do at the end of a course or training is foundational. Developing learning outcomes and assessment and instructional materials that are aligned with one another precedes any and all design efforts. This book assumes you have a good understanding of course development. That being understood, text is not enough! As technology advances, you no longer have to become a webpage designer—or hire one—to create and share content on the Web. Free learning management systems and websites make it possible for professionals from all disciplines to build and share content they create. To have the content shared in the best possible light, everyone needs to know there is more to content design in a learning management system or website than putting words on a page.

So how do we begin to design a course or training for online delivery? Follow along with me on a short visualization exercise. Let’s say you are in the market to purchase a home or lease an apartment. What do you want the neighborhood to look like? As you drive toward a particular home on the market, is the address clearly visible from the curb? When you approach the home, is the pathway to the door obvious? When you walk into the entryway of the home, how does it make you feel? As you tour each room of the house or apartment, can you see exactly where your home furnishings will go? That’s how you begin with your design! Your learners have arrived at the course homepage. What do you want them to see? How do you want them to feel? Where do they go to access various
areas of the course? Once you’ve answered questions like these, you’re ready to consider the visual design of pages throughout your course.

The primary purpose of good visual design is not to make the content page of your learning management system or website pretty, although there is no doubt that an aesthetically pleasing course can have the same appeal as the plate arrangement and garnishes of a well-prepared meal. The purposes of good visual design for online courses and trainings are threefold:

- To create a sense of presence in the course (Akyol, Garrison, & Ozden, 2009)
- To make content accessible to diverse learners (Center for Applied Special Technology, 2011)
- To provide resources at the point of need

Learners want to know that (1) their instructor is a real person who cares about their success in the course and (2) there are other learners in the course with whom they can share perspectives. We’ll discuss these facets of learning communities in the next chapter. Good design ensures that students know who the instructor is and how to contact the instructor. Students know the instructor is there for them when responses to inquiries are timely, feedback informs them of their progress toward learning outcomes, misconceptions are addressed, and dynamic instruction both models and encourages critical thinking among the learners. In addition, good design ensures that content items are accessible to students using a variety of computer and mobile devices, students with varied learning styles, students with a broad range of physical and mental abilities, and students covering the full spectrum of discipline-specific expertise. Lastly, good design removes distractions from the online environment. This is best done by providing the resources students need at the point of need. An online environment free from distractions means students are as close as possible to being one click away from a needed resource. If the visual design of a course fulfills these purposes, learners will experience the support they need to achieve the intended learning outcomes in a distance learning environment.
START WITH WHAT YOU KNOW

Before you panic and say you don’t know anything and that’s why you’re reading this book, think about the computer skills you use every day. Do you use a word processor to outline a lesson plan or prepare a handout for students? What about a presentation program to provide visuals that supplement a lecture? Starting with what you know is a good way to build your confidence and experience small wins when it comes to visually designing a course in a learning management system or website. When I started as a new instructional designer, I came from the faculty ranks as an associate professor of teacher education, specifically in the secondary credential program. All I knew at that time were the basic functions of the Microsoft Office Suite. In planning instruction, I worked primarily with Word and PowerPoint. Those are great tools to build from. Here’s what I mean.

Let’s say I’m building an introduction to teaching course and I want to gather visuals for the perennialist philosophical perspective of teaching. Microsoft Word and PowerPoint are great applications with which to start. Figure 1.2 shows where to find images in Word. After selecting a picture, I can use the Windows 7 Snipping Tool to screenshot the clip art and save it as an image. To locate the Snipping Tool, navigate to the Start menu, locate Programs and Accessories, or click inside the search field and type “Snipping Tool.” Later the background can be removed in PowerPoint (Figure 1.3) and the image can be used to design a graphic that can be uploaded as a content item. Did you already know that? Awesome! Let’s apply what you know to building a content item in a learning management system (LMS). Compared to building a content item with text alone, Figure 1.4 shows three ways to use the graphic in an LMS. The first image in Figure 1.4 is simply unformatted text. However, we’ve already agreed that text is not enough. The second image in Figure 1.4 is a picture by itself. While the picture gives clues to the definition of perennialism as a teaching philosophy, there is more that we can do. Let’s move the image into PowerPoint. Since I am not a graphic artist, I can take advantage of the many layouts and themes to create an original image. After selecting a layout, the picture is imported and the background is removed, using
PowerPoint’s background removal features, as shown in Figure 1.3. The objectives are added to the slide to focus the learner on the expected outcomes, as shown in the third image in Figure 1.4. The last image in Figure 1.4 is the title page layout. Not a bad design for a newbie, is it? This is a great beginning if you find yourself in the position of building courses with no background in design.

I took the following steps to create the images in Figure 1.4:

1. In PowerPoint 2013, access the online pictures from the “Insert” tab, and search for a desired image. If you have an earlier version of PowerPoint, the steps may differ.

2. Once the image is in PowerPoint, select the image and access the “Background Removal” feature located on the “Format” tab as shown in Figure 1.3.

3. Using the “Mark Areas to Keep” and “Mark Areas to Remove” buttons, click-and-drag, or trace the portion of the image you want to manipulate.
**Perennialism**

In this unit you will:
- Define perennialism
- Identify advantages and disadvantages of perennialism
- Create a floor plan for a perennialist classroom

---

**Figure 1.4** Four ways to create a visual for an instructional unit presented online
4. Once you have modified the image to your satisfaction, deselect the image and move it into the desired position on the slide.

5. Add formatted text as desired.

6. Save the slide, using the “Save as” feature on the “File” tab.

7. Use “Save as type” to change from PowerPoint Presentation to PNG.

Now that the PowerPoint slide is a PNG image, you are ready to import the image into the LMS or onto your website.

**DESIGNING CONTENT PAGES**

To create the look and feel you desire for your course, you will be designing different types of content pages. A content page contains the information that learners need to pursue learning outcomes. Four types of pages are common: the “landing page,” “navigation page,” “instructional page,” and “assignment submission page.” These pages are the bases from which students will perceive the instructor’s presence in the online environment and receive the resources needed to achieve learning outcomes. As such, each type of content page serves a specific function.

**The Landing Page**

Just as your impression of a home or apartment is influenced by its curb appeal, the landing page sets the tone of the course. It’s the first page students see, where they form their first impressions. When students arrive on the landing page, it’s the instructor’s first opportunity to make them feel welcome and provide the information needed to begin the course. Students will have many questions when they enter the course. How do I contact my instructor? Where is the course syllabus? What are the required texts for the course? What assignments are due, and when? The landing page is where many of these questions are addressed, with the first manifestation of the instructor’s presence. Consider adding a picture of yourself (smiling!), accompanied by a welcome note written in the first person, which conveys warmth and hospitality. Some learners may enter the
course with anxiety about the content or the online environment, and the smiling face of the instructor, with a welcome note, presents the instructor as personable and approachable.

The following are the steps taken to create the soft-edge effect on a portrait, as seen in Figure 1.5, that you might use to display a picture of yourself.

1. In PowerPoint, click the Picture icon on the “Insert” tab and navigate to a portrait of yourself.
2. Once the portrait is in PowerPoint, select the portrait and click the “Format” tab.
3. On the “Format” tab, you’ll see the “Picture Styles” group. Locate and select the oval with soft edges.
4. To save the picture for later use, right-click the portrait and select “Save as Picture.”

Now you’re ready to upload the picture in the LMS or onto a website. Using tables to format images and text, as seen in Figure 1.5, is discussed in Chapter 5.

A well-designed landing page will introduce the instructor and answer the basic how-to-get-started questions that students need to know to begin the course. The landing page in Figure 1.5 displays a picture of the professor and suggests how to begin the course: by viewing a course introduction video, a syllabus review video and participating in the introductory discussion board activity. All of these items are accessible from the Week Zero folder, clearly visible under the instructor’s welcome as part of the landing page. Some professors include a screencasted orientation or welcome video on the landing page such as the one in Figure 1.6.

Upon reviewing many online courses, it’s clear that the landing pages of exemplary courses tend to share several attributes. Among the first content items encountered are an instructor picture, welcome message, or video message. And among these items, an overview of the course could be provided along with a screencasted video of the LMS user interface. In addition to a screenshot of a professor’s embedded video message, Figure 1.6 shows a banner related to the course content. Banner, whether provided with publisher text materials or created with graphic design web tools,
serve as a visual confirmation that the learner has accessed the correct course in the LMS. This serves the same purpose as writing the course and instructor name on the whiteboard on the first day of a face-to-face class. The landing page also provides guidance on how to proceed after arriving. The learner’s eye instinctively scans the landing page looking for where
to go next. Therefore, it’s a good idea to make sure access to instructional materials is readily apparent on the landing page; say, by way of a link on a side menu or embedded in the text of the content page.

**The Navigation Page**

Another type of page that differs in function from the landing page is the navigation page. This provides access points to instructional materials and resources in the online environment. They can be links on a sidebar, as seen in Figure 1.7, or links in the table of contents, as seen in Figure 1.8. Navigation pages can lead to a single page of content or a single page with additional points of access to content. For example, the course menu in Figure 1.5 contains a link to learning activities. The learning activities link leads to a page that accesses several learning modules. In contrast, the syllabus link leads to one specific content page. For regularly accessed content, links on a sidebar or table of contents provide quick and convenient access points—a very common attribute among exemplary courses.

Navigation pages can also function as a landing page, as seen in Figure 1.5. Providing a single page as both a landing page and navigation page reduces the number of clicks needed to access a single piece of content.
which minimizes page loading time and increases the learner’s time on task. Navigation pages in exemplary courses tend to have short, descriptive link titles as seen in Figure 1.5; some use a grouped navigation scheme as seen in Figure 1.7. A grouped navigation scheme for the sidebar course menu is helpful when accessing related items. Notice that the course menu is divided into three parts—course information links, instructional units, and additional student resources. Because of the related groupings, learning modules are easy to access from any place within the course, as are the course syllabus and student grades.
The Instructional Page

An instructional page calls for different considerations from the landing and navigation pages. Instructional pages contain content to facilitate the attainment of learner outcomes. This might include course objectives, lectures, reading assignments, supplemental resources, and assessment activities. Any task a learner is asked to read, watch, review, and complete will be designed as an instructional page. Organization and planning of instructional pages differs considerably from the organization and planning of a face-to-face course. In a face-to-face course, you can begin with an outline or tentative agenda for weekly sessions and fine-tune those plans as the course unfolds, based on the interactions with students. With online class preparation, absolutely every detail—all directions, student resources, plans for interactions—is laid out before the class begins. If you begin with the end in mind, you can identify the sequential steps or objectives that must be attained in order to achieve the final learning outcome. Once you have segmented the final learning outcome into learning objectives, you can develop small instructional units, align learning objectives with instructional resources and assessments, and design individual instructional pages.
There are several best practices for designing instructional pages that have been gleaned from the voluntary peer review process of exemplary courses. Instructional pages generally include identification of measurable and observable goals and objectives; presentation of instructional content in well-sequenced, manageable lessons, units, or modules; and fostering of higher-order thinking for learner engagement. Course goals and objectives are usually located in the course syllabus. However, they can also be built into the LMS or website. Figure 1.5 shows the learning objectives displayed on the outside of the week one learning module. Figure 1.8 shows the reading objectives on the first page in a unit folder. Best practices in the online space suggest that goals and objectives should be explicitly stated in multiple areas in the course.

Instructional pages are also the pages that provide learners with just-in-time support at the point of need. If a learner needs to view a video, ideally the video will be embedded on the page with a Play button so the learner can view the video without navigating to any other location, as shown in Figure 1.9. If a learner needs to participate in a discussion forum, the access point to that discussion is provided on the page where the discussion is introduced. Whenever possible, avoid asking learners to click to other areas of the course to access a required resource. This risks frustrating learners if they can’t locate the resource.

The Submission Page

The submission page serves as a repository for student work. As such, the page may contain a text editor for typing directly on the submission page or a link to upload files from the student’s computer. Depending on the features available in the LMS or website, you may have submission pages for assignments, discussion forum responses, journal entries, blog posts, and wiki pages. Submission pages may communicate with the LMS’s grade center function or contain submit buttons linked to the instructor’s e-mail address. Figure 1.9 shows a submission page where a student will upload a completed project. To enhance navigation and minimize excessive content links, the submission area provides access to the project lecture in the same place where the finished project will be uploaded.
In addition, a PowerPoint file with slide notes is used as a lecture transcript in the same location to enhance accessibility to the curriculum. The PowerPoint file is free of transitions and animation so those using assistive devices can access the content. Furthermore, in case the lecture is not visible, a labeled link to the lecture is provided in a format accessible to screen readers.

**Figure 1.9** Instructional page with related instructional materials in one content item; the page also functions as a submission page

**KEEP THE DESIGN L.I.T.E.**

Although each content page serves different specific functions, simplicity and clarity are the important aims for all content pages. Let’s look at the ways in which the L.I.T.E. skills help us avoid a M.E.S.S. in the design of an online course or training. The technology skills of creating active links, integrating related multimedia content, using typography to create white
space, and embedding resources at the point of need are the basic skills required to keep the course design L.I.T.E. By using these technology skills we can manage the folder depth ratio, eliminate excessive content, streamline related content, and support learner access, thereby avoiding a M.E.S.S.

**Link to Content**

Let’s say I wanted to e-mail you the recipe for my favorite holiday dessert. When I type the e-mail, I have two options. First, I could list the ingredients and describe step-by-step how to make the recipe from scratch. This option would make the e-mail very lengthy. The recipe might seem complicated and discourage you from attempting it. The second option would be to e-mail you a list of ingredients, followed by directions of three to four short sentences explaining how to combine and bake the ingredients. To ensure that you understood all the nuances of preparing the recipe correctly, I could create links in the e-mail to vital information. For example, the ingredients list might show “4 eggs, separated” as a link. When you click on the link in the body of the e-mail, it might take you to a short video demonstration of separating egg yolks from whites. I might link the phrase “double boiler” in the recipe steps to a picture of a double boiler on the Web, with directions for use. Linking to external content allows me to explain the recipe instructions simply and clearly while providing the additional information you need but may not know.

Here’s another example. Figure 1.10 shows an assignment exercise. While I have the option of using direct instruction, to embed a lecture that explains how to choose a computer, buy a webcam, or understand computer specifications, Figure 1.10 shows a preference for a constructivist’s discovery approach to engaging the learner with course content. This approach encourages learners to construct meaning from the interactions they have with instructional materials and conversations with peers and experts (Bain, 2004). The image of the PowerPoint slide contains a text description of the objective for the exercise. The image is hyperlinked to an instructor-narrated video of the guided exercise. Below the image are
several clickable resource links that learners use to explore the learning objective. The page requires minimal scrolling, as it contains everything the learner needs, including a transcript of the instructor-created video.

**Integrate Multimedia and Similar Content Items**

I remember back in the day when I could travel without being charged for one or two pieces of luggage. Aside from packing everything I needed for a trip, I packed everything I thought I might need. Like extra sweaters and a parka in case it got cold at Lake Havasu in July. Now that airlines are charging to check luggage, I’ve learned to pack only what I need into a carry-on for trips of less than five days. I can get five days of clothes and
vanity items into a backpack. Roll those shirts, jeans, and undergarments tightly, so they take up as little space as possible, and I can still fit in my small tablet for in-flight entertainment. Similarly, integrating multimedia and merging related instructional items allows you to manage the appearance and number of items in a learning module.

The visual benefits of linking to external content are exponential when multiple content items are integrated into one. Compare Figure 1.1 (my M.E.S.S.) with Figure 1.11. Figure 1.1 shows a folder labeled “cognitive presence,” with eight separate content items related to Twitter. There’s a content item to explain what Twitter is, what a Twitter Search is, and how these might be used in the classroom. There is also a Twitter survey and a list of Twitter activities with directions on how to tweet, how to send a direct message, and how to add Twitter to your cell phone. If you’re a faculty member who doesn’t tweet, eight content items on an unfamiliar web tool may be overwhelming and discouraging. In contrast, Figure 1.11 shows seven of the eight content items integrated into one. One content item now contains a video explanation of Twitter and Twitter Search; two linked documents contain hyperlinks to Twitter use in the classroom, Twitter activities, cell phone usage with Twitter, and directions to perform basic Twitter functions. Wow, how refreshing! If the faculty member doesn’t tweet, it may be easier to remain open-minded about Twitter use in the classroom if there is only one content item on the topic. Notice in Figure 1.11 that the vertical scroll bar has been removed from the table of contents as a result of linking to content and integrating multimedia and similar content items.

Use Typography and White Space

We see the printed word almost everywhere we look. Big print. Small print. Bold print. Italicized print. Decorative print. Serif and sans-serif print. So much so that we take for granted the white space around the words or graphics (Williams, 2008). It’s tempting to see white space as wasted space or space that begs to be filled with something, anything. This notion couldn’t be further from the truth.
There are some basic typographic elements common to course design in a learning management system or website. Typically, a “what you see is what you get” (WYSIWYG) editor allows you to manage point size, line spacing, line length, and font choice fairly easily. These same tools create white space (Vai & Sosulski, 2011). Why would we want to leave unused space on a content page? There are several reasons. For one, white space helps to draw attention to important content on a page. This could be section headers, key words or phrases, or graphics. White space also enhances readability, allowing you to scan a page for specific sections of
text for example. When used well, we don’t notice the typography or the white space, just the content on the page.

How can basic typography tools of point size, line spacing, line length, and font choice create white space? The smaller the font size, the less white space is created, and reading fluently becomes a challenge. Using a 12- to 14-point font is fairly standard, according to style formatting guidelines like APA (American Psychological Association) and MLA (Modern Language Association). Compare the point sizes in Figure 1.12. Single line spacing is also common when reading on a computer screen, as double spacing can force excessive scrolling. However, for longer bodies of text, 1.5 to double spacing is common between paragraphs. Again, this creates white space that enhances readability. Line length can be managed by breaking out numbered or bulleted lists rather than itemizing a list in running text. The indents associated with numbered or bulleted lists create white space that contributes to a balanced appearance and content organization.

Heading styles are a typical feature in WYSIWYG editors. Heading styles have associated line spacing. Most WYSIWYG editors come with only a few basic fonts like Verdana, Courier, Geneva, Helvetica, and Arial. Unless there is a specific reason to stray from these, stick with the classic fonts for legibility—that is, the readability of individual letters. The population as a whole is spending more time looking at computer screens (Greenfield, 2014). Decorative fonts are not easy to read for extended periods of time, so their use should be kept to a minimum for academic and training purposes.

Figure 1.12 Line spacing and length, and font style and size contribute to readability through the creation of white space.
Embed Content

Some time ago, my daughters and I went to the theatre to see a musical. As we approached the entrance, one of my daughters suggested we go to a mini market to purchase some candy and gum for the intermission. Although we arrived at the theatre early, there was no mini market or gas station with a mini market within walking distance. When we walked into the theatre, we noticed the concession stand in the center of the foyer. As we expected, the prices were outrageous: a small bag of peanut M&Ms cost $5. You’d think we’d walk away appalled at such an outrageous price. Instead, we laughed at ourselves for not being prepared, paid the $5, and enjoyed every one of those peanut M&Ms. Why? Convenience. Given our failure to come prepared, we saved ourselves time and energy by purchasing the conveniently available—albeit high-priced—candy.

Similarly, embedding content in your course makes content convenient to access and provides learner support in the online environment, helping learners use their study time efficiently. To effectively embed content means the material is visible and ready to view at the point of need. Technically all content, whether displayed as a link or text, is embedded. However, when we use the term “embed” in this context, we’re referring to content that is visible at the point where the user encounters it. For example, Figures 1.9 and 1.11 show an embedded video. The user just needs to click the Play button to view the content in the location where it’s presented, versus clicking on a link that opens in a new window or cutting and pasting an unclickable URL into a separate browser window. Embedding content reduces the number of clicks needed to access the content. Reducing the number of clicks saves page loading time, which will vary for students based on internet connection speeds and usage demands. Reducing time spent in noninstructional actions leads to better time management, which is particularly important to working adults with families. Figure 1.13 shows where embed codes should be placed. Look for an HTML icon, toggle switch, or widget in your content building environment.
SUMMARY

In this chapter we discussed beginning the visual design of an online course or training by understanding the types of pages used in a course. The landing, navigation, instructional, and submission pages each serve a unique function in the course and should be designed with simplicity and clarity in mind. This can be achieved through the four basic technology skills needed to visually design a course in a learning management system or website. These skills were presented using the acronym L.I.T.E. for being able to link, integrate, use typeface, and embed content.

WHAT’S NEXT?

There are many learning management systems on the market, some proprietary, some free. In addition, many free websites are template driven. Both types of course design platforms come with text editors that vary in the features they offer. Identify a learning management system or
website in which to build a course and make sure you can do the following in the platform you choose:

1. Create a link to external content. Words, phrases, or images can be used to create links to websites, e-mail addresses, and internal content. Most text editors contain a Link icon like the one shown here.

2. Locate embed codes. Typically this will be a link that indicates “sharing,” followed by the word “embed.” You’ll often see a Share icon followed by multiple options. Although Share icons vary in appearance and embed codes vary in length, the following graphics illustrate what a Share icon and an Embed icon might look like.

3. Locate the font, point size, and line spacing functions in your text editor. These basic tools help create white space and contribute to readability. The appearance of icons will vary, but you’re looking for an icon with a single printed letter, a drop-down menu of point sizes, and a Line Spacing icon with three or four horizontal lines with vertical directional arrows. Not all text editors contain these features, and they may not be readily visible. However, it’s important to know what tools you have to work with from the outset.

4. Locate features in the text editor that affect line length, such as numbered lists, bullets, and indents.

5. Practice asking Google. If you can’t find it or figure it out, ask Google! When I first started working as an instructional designer, I would constantly ask my web developer colleague tech questions. His response was often “Did you Google it?” This was my first lesson in tech independence. Google is capable of returning decent search results even when you type a run-on sentence like “where on earth is a Blackboard tutorial on the text editor.”